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Welcome to your new EVO 16 Audio Interface. EVO 16 has been designed
to remove the technical barriers creatives face when exploring the often
intimidating world of audio and make recording simple for everyone.

We hope you enjoy using EVO 16 and it helps you in your creative
endeavours, whatever they may bel

Work smarter not harder.
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DECLARATION OF CONFORMITIES

This apparatus has been tested and found to comply with the limits of
a class-A digital device, pursuant to Part 15B of the FCC Rules. These
limits are designed to provide reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can radiate radio frequency
energy and if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications.

If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or
more of the following measures:

01 Re-orient or relocate the receiving 02 Increase the separation between the
antenna equipment and receiver

03 Connect the equipment into an 04 Consult the dealer or an experienced
outlet on a different circuit from that radio/TV technician for help

to which the receiver is connected



C€

UK
CA

WoHS

P!

METI

initry f conomy Tade and Industry

We, EVO Audient, Aspect House, Herriard, Hampshire, RG25 2PN, UK,
01256 381944, declare under our sole responsibility that the product EVO 16
complies with Part 15 of FCC Rules.

Operation is subject fo the following two conditions:

1. This device may not cause harmful interference,
2. This device must accept any interference received,
including interference that may cause undesired operation

We, EVO Audient, declare that the product, the EVO 16, to which this declaration
relates, is in material conformity with the appropriate CE standards and
directives for an audio product designed for consumer use.

We, EVO Audient, declare that the product, the EVO 16, to which this declaration
relates, is in material conformity with the appropriate UKCA standards and
directives for an audio product designed for consumer use.

Audient Ltd has conformed where applicable, to the European Union’s Directive

EN 63000:2018 on Restrictions of Hazardous Substances (RoHS) as well as the following
sections of California law which refer to RoHS, namely sections 25214.10, 25214.10.2, and 58012,
Health and Safety Code; Section 42475.2, Public Resources

Under an environment with electrostatic discharge, the device may cease to output sound
(EUT could not operate properly). This requires the user reset the device by unplugging &
re-connecting to host computer.

As a device that provides power to other equipment power management features are
inappropriate for this product.

We, EVO Audient, declare that the product, the EVO 16, to which this declaration relates, is in

material conformity with the appropriate PSE standards and directives for an audio product
designed for consumer use. METI Ordinance Appendix 12 |55032(H29).

IEC 62368 Test Report with Japan deviation.



‘ macOS

INSTALLATION / SETUP

On macOS, EVO 16 will work straight away without needing to install
any drivers. However, we do recommend installing the EVO Mixer
application, which gives you advanced control over your EVO 16 and
lets you update your firmware when required.

Head to to download the latest version
of the application. Once downloaded, simply open the .dmg file and
then drag and drop the EVO application into your applications folder.
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http://evo.audio/evo16/downloads

Carefully unpack your EVO 16, connect the included power cable and

connect it to a USB port on your Mac. If your computer doesn’t have the

appropriate USB port you may need to use an adaptor, dongle or third

party cable.

You can then set EVO 16 as your main output by going to System
Preferences > Sound and then selecting the EVO 16 as your device for

Input and Output.

System Preferences > Sound

o0 el E System Preferences Q, Search
: | z a«
. = :
General Desktop & Dock Mission Language Security Spotlight  Notifications
Screen Saver Control & Region & Privacy
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Displays Energy Keyboard Mouse Trackpad Printers & \ Sound / Startup
Saver Scanners - Disk
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iCloud Internet Software Network Bluetooth Extensions Sharing
Accounts Update
[VELTER Parental Siri Date & Time Time Accessibility
Groups Controls Machine

System Requirements:

macOS 10.13.x (High Sierra) or Later
Mac Intel CPU or Apple Silicon
1GB RAM Minimum

Select EVO 16 as input / output

eeo P FD Sound
~ Sound Effects Output 7Input7
Select a device for sound output:
Name Type
Audient EVO16 usB
BlackHole 16ch
MacBook Pro Speakers Built-in
Soundflower (2ch)
Soundflower (64ch)
Loopback Audio
Settings for the selected device:
The selected device has no output controls
Output volume: 5 oo )))

Show volume in menu bar

Q_Search



Bl Windows

INSTALLATION / SETUP

EVO 16 will require drivers to work on Windows to ensure your computer
and EVO 16 will work together correctly. You can download the drivers
from the EVO website:

Once downloaded, run the .exe file to start the installation process.

Welcome to the Audient EVO
v4.2 3a Setup Wizard

will guide you through the installation of the
SB Audio Drive

computer.

Click Next to continue.

Cancel

Follow the instructions on screen to complete the installation.
This process may take a little while so please be patient.

System Requirements:
Windows 10 or Later

Intel Core 2 @1.6Ghz, or AMD equivalent
1GB RAM Minimum


http://evo.audio/evo16/downloads

Completing EVO Setup

Once complete, click finish. Now carefully unpack your EVO 16, power it
on using the included power lead and connect it to the computer using
the included USB cable.

To set the EVO 16 as your default sound device, go to Control Panel >
Hardware and Sound > Sound. Now select the Playback tab.

In the list of devices, find EVO 16 Main Output 1+2, click on it and select
Set Default Device.

Any audio played back from your PC will now be played through EVO 16.

Follow the same process for the Recording devices by selecting Inputs
1+2 from the list of input devices.

For more advanced settings such as changing your sample rate or
buffer size, please read the Software features section, found later in
this manual.



REGISTRATION WITH AUDIENT ARC

ARC

Compatible with all major audio software, EVO 16 comes bundled with
a collection of professional software and services, giving you everything
you need to start recording.

Go to arc.audient.com and select “register your product” and enter

your details to create an account.

You will then receive a verification email to your inbox, double check
your Spam and Junk folders if you cannot see this. Once you've verified
your account, register your EVO 16 by entering the serial number and
the unique 4 digit PIN found on the bottom of the EVO 16.

Once you have registered the product, you can now select from a wide
array of free software and plugins, giving you easy access to powerful
creative tools straight away.


http://arc.audient.com
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HARDWARE FEATURES

Initial Setup

The Motion User Interface is a control system designed to change the way
you interact with your audio interface. For the first time, a stunning high
resolution, full colour screen intelligently displays information as you need
it, transforming EVO 16 into a fully immersive, easy to use experience.

The first time powering on EVO 16, Motion Ul will ask to follow the setup
procedure, allowing you to customise EVO 16’s settings to your liking.

Firstly, you can adjust and set the brightness of all of EVO 16’s hardware
LEDs, including the LED Ring, to suit your studio environment. Use the

Control Wheel to adjust the slider and then press the Control Wheel down
to save your settings and then hit ‘Next’

Brightness -O-
VO 16 Welcome - —

NS



Next, you can choose which monitoring feature is assigned to the hardware
F Button on the front of the unit when pressed:

Function Button
< DIM > e %o o
.. ~— a 1 2
° 2 I' s‘

L4 ‘\_/' ~
Talkback
DIM - Reduces the output level to the speakers by a set value
ALT Speakers - Switches between the Main and ALT Speaker outputs
Talkback - Toggles Talkback on and off
Mono - Sums the Monitor outputs to Mono

More detail on the Function Button and its settings can be found later in this

manual.

Once selected, click ‘Finish’ to complete the setup.

Setup
Complete




Mic Preamps and Line Level Inputs

EVO 16 includes eight high-quality EVO Mic Preamps, available through the
Combi jacks on the front and rear of the unit.
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EVO 16 can lower the signal level by 8 decibels and boost it by up to 50
decibels allowing you to get the perfect recording level, this is known as the
gain.



When pressing any input button on EVO 16’s front panel, the input screen
will show the Input Status Screen. The status screen will display: the input
number, the input name assigned via the EVO Software Mixer, the gain
setting in dB, and an independent channel meter for referencing your levels.

Input 1 Vocals

Gain

When an input is selected, the hardware will now control that channel, so
you can use the Control Wheel to adjust the input gain with decibel level
accuracy, as well as toggling channel mute, phantom power for condenser
mics, or instrument mode for guitars and basses on channel 1+2.

Input Buttons Control Wheel
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Smartgain Mode

Smartgain is a powerful feature which helps you get recording as quickly as
possible. It is able to listen to all the activated inputs, and set gain within a
matter of seconds.

To activate Smartgain, press the green Smartgain button, you will then be
prompted to select the channels you want to set the gain for. Select the
channels you want using the channel buttons or press and hold the Smartgain
button to quickly select all 8 channels at once.

Select
Channels

Once you have selected the channels you require, press the Smartgain button
again to start. You will now see a ‘Smartgain Listening’ screen, this is where you
or your artist will need to start performing in order for Smartgain to analyse
your signal.

Smartgain
Listening



If all selected channels are successfully set, you will see the ‘Smartgain
Successful’ screen and you are ready to start recording.

Smartgain
Successful

If Smartgain fails for any reason you will see the ‘Issue Detected’ screen
followed by the Smartgain Status screen. The Smartgain Status screen gives
you an overview of the status of each channel in relation to Smartgain.

Status
Y o
I

Defzgteed ‘ ‘




Green - means it was successful
Red - means it failed
Grey - means the channel was not selected

Smartgain will now return you to the ‘Select Channels’ screen with the failed
channels automatically pre-selected, simply press Smartgain to start the
process again.

For the channels that failed, double-check your microphone cables, check
if phantom power is required for that microphone, or move the microphone
closer to the sound source. Then try the Smartgain process again.

Note: there is no need to select the green channels again as they were
already successfully set.



Input Mute

To quickly mute a channel, simply hold down the hardware channel button
until the Mute Feature Toggle screen is shown, and the channel button begins

flashing.

nput 1 Vocals Input 1 Vocals

Mute On Mute Off

When a channel is muted, the gain level is replaced with the Mute icon, this will
remain in place until mute is deactivated, by again holding down the channel

button.

Input 1 Vocals

Mute On



StereoLinking () &) &) () &) () ()

All of the input channels can be linked as stereo pairs, for example: Channel
142, 3+4, 5+6, 7+8. This allows you to match the gain for both channels to make
sure your left and right channels are at the same level.

This would be used when recording an instrument using two microphones,
such as a piano or guitar, or if inputting a stereo line signal like a synth or DJ
decks.

To do this, press down the pair of input buttons (eg. 3 & 4) at the same time.The
channels in the EVO Software Mixer will then automatically change to a stereo
channel to reflect this (refer to the Software Mixer section of this manual).

Whilst two channels are linked, selecting one of the channels will automatically
select the linked channel as well.

48V &
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When two channels are linked, a ‘Link” icon will appear on the Input Status
Screen and the input name will update.

Input 1+2 Vocals

Gain @

When on the input metering screen, you will also see a small hyphen
connecting the linked channel numbers.

Inputs

5 6 7 8

1-2 3-4



Phantom Power (48V)

Some microphones will require phantom power in order to function. This is
+48 volts of power sent via the XLR cable and used to correctly power up
the microphone and allow it to work.

Microphones that require phantom power are typically condenser
microphones.

In rare cases, some microphones that don’t require phantom power can
be damaged by providing phantom power to them so we'd recommend
checking the microphone’s documentation to see if you need to provide
phantom power or not.

1 3 5 7 | eV (@
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To activate phantom power, select the channel, then press the 48V button,
which will then illuminate red as well as activate a temporary popup on
screen.

This is set independently per channel so if you navigate away to a different
channel, where phantom power isn't activated, the 48V button will no

longer be illuminated.

To turn off 48V, press the 48V button again, which will display the feature
toggle screen.

When turning on and off phantom power, EVO 16 will automatically mute
the input to avoid unwanted noises coming through to your speakers or
headphones.

Input 1 Vocals Input 1 Vocals

Phantom On Phantom Off



Instrument Input /

EVO 16 includes two instrument inputs to directly connect instruments such
as electric guitars and basses. The instrument input is sometimes also known
as a DI (Direct Injection) and provides a high input impedance, which enables
you to get the best tone from your instruments.

The two instrument inputs are found on the front of EVO 16, and accept
unbalanced TS jacks, just like the ones you'd plug into a guitar amp.

By default, these inputs are used as line & microphone level inputs but they
can both be changed to Instrument Mode.

Instrument Inputs Instrument Button

1 MICILNEIINSTR 2
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To do this, select either channel 1 or 2, then press the Instrument button. The
button will then illuminate as well as display the temporary popup on screen.
To turn off Instrument mode, press the Instrument button again.



Input 1 Guitar Input 1 Guitar

Inst On Inst Off

If you try and activate phantom power on Channels 1+2 whilst the instrument
input is active, an error screen will show as it is not possible to have both active
at once.

Input 1 Guitar

Inst On

When using the instrument inputs set your gain as you would with the Mic/
Line inputs, either using Smartgain or the Control Wheel.

Remember: After you've finished recording via the instrument inputs, you’ll
need to switch them back to line & microphone level inputs. To do this, press
whichever instrument channel button you're using, then press the Instrument
button. This essentially turns off the DI circuit, allowing you to use line and &
microphone level devices.



ANALOGUE OUTPUTS

Headphone Outputs

EVO 16 provides you with separate controls for each of the headphone
outputs. Pressing the Headphone 1 or 2 button will allow you to independently
adjust the volume for each output. To adjust the output volume, simply tap
the output you wish to adjust and turn the Control Wheel. The Meter ring will

iluminate to show the current volume level.

Headphone Control Buttons
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Line Outputs

EVO 16 also provides you with eight dedicated line level outputs, which can
be found at the rear of the unit.

By default, pressing the Speaker button on the front of the unit, then turning
the Control Wheel will change the volume of line outputs 1+2. You can adjust
any of the other line outputs in the EVO Software Mixer.

Speaker Button



Pressing any of the hardware Output buttons will bring up the Output Status
Screen. Similarto the Input Status Screen, with a few key differences, the Output
Status Screen displays: the output name, the volume level, stereo meters, as
well as a feature status display. With an output selected, the Control Wheel will
now control the volume of that output, ranging from O to 100.

Output Main

Volume

To quickly mute an output, hold down the channel button until the Mute
screen is shown, and the channel button begins flashing. When a channel
is muted, the volume level is replaced with the Mute icon, this will remain in
place until mute is deactivated, by again holding down the output button.

Output Main

O

Mute On
]
]



Function Button

Various monitoring and communication functions of the EVO Software Mixer
can be assigned to the hardware Function Button found on the front panel of
the EVO 16. This enables you to quickly control your monitoring at the click of a
button. To assign a monitor control to the F-Button, refer to either the Software
Mixer or Motion Ul Settings section of this manual.

The following functions can be assigned:

Mono

Sums the stereo outputs down to mono. This can be used to quickly check the
mono compatibility of your mix to make sure it’ll sound great almost anywherel

ALT
ALT allows you to quickly switch your monitor path to a secondary set of speakers

to let you check how your mix translates on various speakers. You can select
which outputs the ALT monitor control flips to in the System Panel.

Dim

Reduces the output level by a pre-set amount which can be great if you get a
call or need to quickly chat to someone during a session.

TB (Talkback)

Toggles talkback on and off.



With the main speaker outputs selected, under the meter, you are able to
see the status of the output functions, Dim, ALT speakers, and Mono.

Output Main

Volume

Wheneverthese features aretoggled, the corresponding screenisdisplayed,
before reverting back to the output status screen.

ALT DIM MONO
Speakers On On On
ALT DIM MONO

Speakers Off Off Off




Talkback

The F-button can also be used to activate Talkback, enabling you to stay
in contact with an artist through their headphones. This is configured in the
EVO Mixer App’s Settings Panel.

When Talkback is activated, whether using the F-button or the EVO
Software Mixer, the Talkback screen is breifly shown.

Q)
(0

Talkback Talkback
Oon Off

If at any point you navigate to a different screen while talkback is still
activated, the Talkback Icon will be visible.

Inputs 2’ Inputl S Vocals Output &)

+
Gain Volume
1 2 3 4 5 6 7 8

HP1






OPTICAL INPUTS & OUTPUTS

EVO 16 features two optical inputs and two optical outputs. Each of these
can be set to operate using optical stereo S/PDIF or 8-channel ADAT using
the EVO Software Mixer. Alli/o will operate at up to 96kHz, with ADAT dropping
to 4 channels at sample rates of 88.2kHz or higher.
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Running in S/PDIF mode, the optical i/o provides the option to integrate
external digital outboard, allowing up to 4 channels of audio in and out of
the EVO 16 at sample rates up to 96KHz.

Running in ADAT mode, the optical i/o provides a great way to expand to 24
inputs for recording via an external mic preamps such as the Audient ASP800.
The ADAT outputs could also be connected to headphone distribution systems
such as a HearbackTM system or to an 8-channel DAC for summing purposes.

When using higher sample rates such as 88.2kHz and 96kHz, you are restricted
to a total of 8 digital inputs and 8 digital outputs due to the limitations of the
ADAT protocol.



World Clock Output

The EVO 16 includes a BNC Word Clock output which allows you to clock multiple
digital devices to the EVO 16’s master clock and keep everything in sync.

The Word Clock output will send a clock signal at the same sample rate (441,
48, 88.2 or 96kHz) that the EVO 16 is operating at. This will occur regardless of
whether the EVO 16 is being clocked internally or externally.

Clocking Configurations

When connecting external digital devices to the EVO 16, it’s important to ensure
that all devices are synchronised.

To ensure this, one device in the setup must be set as the master clock. The other
devices will then use the master clock signal to stay in sync. There can only ever
be one masterclock present in a chain.

The master clock signal can be sent either via an optical cable embedded into
the digital signal data, or through a BNC clock line cable. Please bear in mind
that the clock will only travel in one direction through these connections, from
a device’s output to a device’s input.

Choosing a Master Clock

In a digital setup, there can be a number of options when determining which
device should be your master clock. Quite often the best device to set as the
masteris the one thatis connected to the computer such as an audio interface.
This way, when you open a project in a DAW, the audio interface should change
automatically to match the project sample rate, and therefore change the
sample rate of all the slave devices. However this depends on the devices being
used.



EVO 16 as the Master Clock

With the EVO 16 set as the master clock the other devices in the chain can be
clocked by either the optical output port or the BNC word clock output.

If you are using multiple devices then it is recommended to use the BNC word
clock output and then use T-connectors to daisy chain the devices together.
It is important to note that the final device in the chain should have its BNC
connector terminated with 75 Ohms to stop reflections of the clock signal. This
should be a switchable option on most devices.

Key: Optical TOSlink Cable BNC Word Clock Cable
——————————— > —
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EVO 16 with daisy chained BNC connection

]

|

]

]

2 our i/ s X | 8 7 6 5 4 3 i
L SO 1010 1010Y BNC T Connector | 1
|

1

|

1

evo

ilien

75 Ohm Terminated

EVO 16 as the Slave Clock

The EVO 16 can also act as the slave to an external master clock via it’s optical
inputs. In this case, you would connect the optical output of a device to the EVO
16’s optical input. Then, in the EVO mixer application, select the optical input
you wish to be used as the clock source. You would also need to set the inputs
to either ADAT or S/PDIF depending on the specification of the external device.

EVO 16 clocked via the optical port

evo ' - 5 [




Metering

When not adjusting settings or pressing buttons on EVO 16 for more than 5
seconds, the screen will default to display either the input or output meters,
depending on whether you last pressed an input or output button.

The input meters display the levels of all 8 channels at the same time,
enabling you to keep track of your recording levels. If you are using the

digital inputs, you can quickly cycle through the input meter screens to
view their levels by pressing the Control Wheel.

Inputs Digital Inputs Line Inputs

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8

The output meters display the levels coming out of your main speaker
outputs and both headphone outputs. Similar to the inputs, you can
navigate to view the level of yourline outputs and digital outputs by tapping
the Control Wheel.

Outputs Digital Outputs Line Outputs

HP2 1 4 5 6 7 8 1 4 5 6 7 8

Main HPI1 2 3 2 3



Motion Ul Menu

In the Motion Ul menu, you will find the options to power the unit down,
customise the brightness levels of the LEDs, adjust the Sleep Timeout, assign
any of the monitoring functions to the hardware F-button, check the audio
status of your unit, and reset the unit to the factory settings.

To open the Motion Ul menu, momentarily hold the Control Wheel down.

Settings

Power

Brightness

Sleep Timeout

< Function Button )

Status

Factory Reset

Exit




Power

To power off the unit, rotate the Control Wheel until Power is selected, and
then press the Control Wheel down to select. You will then be prompted
to confirm if you want to turn off EVO 16, select Yes, and press the Control

Wheel to confirm.

Power Off?

Powering off... Goodbye

No Yes

This will put EVO 16 in a low-power standby mode. To turn the unit back on,
hold down the Control Wheel until the screen illuminates.

You can also turn off EVO 16 without navigating to the settings menu by
simply holding the Control Wheel down for 5 seconds.



Function Button

This allows you to choose what the F-button on the front panel controls.
Here, rotate the Control Wheel between the different options, and press
the Control Wheel to select it. Then press OK to confirm your selection.

Settings Function Button

Power < DIM >

< Function Button > Talkback

CtAtiie D oo = =0 ~is

Brightness

The brightness option allows you to adjust the brightness of the LEDs to

reduce glare in darker studios.

Settings
Brightness -O-
Power

< Brightness > ) . :

Function Button Cancel OK




Sleep Timeout

EVO 16 will automatically enter sleep mode if it passes no audio for a set
amount of time to save power.

The Sleep Timeout setting allows you to define how long the EVO 16 will stay
awake for when idle before entering sleep mode. You can select from the
following options:

¢ 5 Minutes

e 15 Minutes

e 30 Minutes

e 1Hour

o Off (Disables sleep entirely)

Status Menu Screen

The status screen displays the sample rate EVO 16 is currently set to via the
EVO Mixer as well as showing what protocol both the digital inputs are set
to and whether they have been successfully clocked.

Sample Rate

Brightness 1
8 kHz

Function Button

Digital Inputs
< Status >
DIGIn1. ADAT e

Factory Reset DIGIN2: SPDIF ®




If the light is green, this means that the unit has been successfully clocked,
if amber the unit is receiving a signal but in the wrong sample rate, and if
red, no signal is detected. To dismiss the screen, press the Control Wheel.

Note: the sample rate and clock settings cannot be edited from this

Screen.

Factory Reset

To reset EVO 16 to its factory settings, select the factory reset button and
select Yes to start the process.

Brightness
Confirm Factory

Function Button Reset?

\[o) Yes
Status

< Factory Reset >

Note: Be aware this will remove any of your currently saved settings.




EVO 16 RACK MOUNTING

1 MICIUNEIINSTR 2
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How to install the rack mount ears

1. Use a 3mm hex driver to remove the two screws either side near the front
of the unit.

2. Position rack ear so that the four screw holes are inline with the four
holes found on the side of the EVO 16. Refer to the image above for correct
positioning. Insert the x4 M4 screws into the holes, and tighten until firm.
Repeat proccess again for other rack ear.

3. Remove the rubber feet which are located on the bottom of the EVO 16
using a Pozidriv screwdriver.



o Required:

@VO 16 3mm hex driver/key

Pozidriv screwdriver

Caution regarding placement

It is not advised to run the unit in a rack above or below hot units such as valve
outboard and multichannel AD/DA converters without suitable ventilation space
around the unit.

We would suggest a space of at least one rack unit above and below the unit.

Ensure side air vents are not covered. Additionally, do not install near any heat
sources such as radiators, heat registers, stoves, or other apparatus (including
amplifiers) that produce heat.

If the EVO 16 is to be added to a rack that will be regularly transported (i.e live-
audio applications). We strongly recommend adding additional support to the
unit within the rack, such as a rack tray or side supports, to minimise the risk of
damage to the rack ears or to the EVO 16 itself.



SOFTWARE FEATURES

EVO 16 includes a powerful software mixer giving you complete control over
your monitoring and audio loop-back. On MacQOS, the EVO Software Mixer
will open in the Menu Bar in the top right hand corner of the screen.

Show Mixer

About EVO

Visit EVO Knowledge Base
Register Product

Check for Updates

Input Routing b

Quit Q

On Windows It will open in the system tray found in the bottom right hand
corner of the screen.

Show Mixer

About EVO

—, Visit EVO Knowledge Base
Register Product

Check for Updates

Set ASIO Buffer Size
Set Sample Rate

Set Clock Source

v v v v

Input Routing

Quit :tr|+|:;.‘- a .:_':: |;? I:C]IJ]




The Menu gives you the following options:

Show Mixer

This menu item opens the Software Mixer Window. More information about the
mixer can be found in the EVO Mixer section.

Quit

This fully quits the application and stops it from running in the background.

About EVO

The About EVO option allows you to check your current software and firmware
versions and provides further information about the software.

Visit EVO Knowledge Base

This option will open a browser window allowing you to access technical support
and FAQ’s for EVO 16.

Register Product

This will open a browser window for the Audient ARC website where you can
registeryourinterface to access free promotions and software. More information

about ARC can be found on page 12.

Check for Updates
This option will check if any updates are available for your EVO 16 to add new

features or support for future operating systems. If any updates are available
then you'll be prompted to install them.

Input Routing

This allows you to select which channels are sent to your loopback inputs. More
information about loopback can be found on page 63.



EVO SOFTWARE MIXER

The EVO Software Mixer allows you to completely control your monitoring for
recording, mixing or content creation.

00000000m@eGOd & |

AAAAAAA



Each fader has the following functions:

Pan Control

This allows you to monitor the audio on either the left speaker, the right speaker
or anywhere in between.

Stereo/Mono

Adjacent tracks can be stereo linked for when you are recording a stereo source,
such as a synth or when using stereo mic techniques.

Solo (S)

Solo will mute every other input apart from the channels that have the solo
button selected.

Mute (M)

This will mute the track so it is no longer being monitored.

Meter

This shows the current input level of a particular channel. If the signal level is
too high, a red “Clip” indicator will show at the top of the meter. In this instance,
you may need to adjust the gain of your inputs or the volumes in your recording
software.

Phase Flip

Inverts the polarity of the signal by 180° to stop phase cancellation. This is useful
if you are micing the rear of a guitar amplifier or the underside of a snare drum.



Faders

The fader determines how much signal is sent to the outputs. The faders have an
additional 6dB of monitoring gain available allowing you to boost a quiet signal,
this is done by pulling up the fader to the +6dB point.

In the mixer there are multiple channels from different sources. These different

channels are explained below:

]
Mic 1+2
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Mic1,2,3,4,5,6,7&8

These are the eight microphone inputs of the EVO 16. Pulling up the faders for
these channels allows you to listen to the eight inputs through your speakers or
headphones with very low latency.



DAW 1+2, 3+4, 5+6, 7+8

On the far right side of the mixer is the master section. From here you can adjust
the output levels of the line outputs 1+2, 3+4, 5+6, 7+8, which are found at the rear
of the unit.

DAW 142 DAW 3+4 DAW 5+6 DAW 7+8 DAW 9+10 MASTER MIX MIC  OPT DAW
MIX MASTER

®06 66 66 66 ¢ |
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CUE A

CUE B

CUE D

®

This is your playback from your computer, such as playing back recordings or
instruments from your DAW, or just playback from media players or web browsers.
Pulling up the fader for these channels allows you to play this back through your
EVO 16.



The EVO 16 Software Mixer has 8 DAW Return Channels allowing you to set
up multiple cue mixes or sends to hardware outboard gear. Using these three
channel types, you can build up your main monitor mix and up to four additional
cue mixes. Its important to note that the EVO Software Mixer only controls the
monitoring of the EVO 16. Changes made to the EVO Software Mixer won't affect
the level present in your DAW or audio software.

Digital Inputs
These are the inputs from the EVO’s optical inputs. The number of digital inputs

present on the EVO mixer application depends on the digital input type (S/PDIF
or ADAT) and the sample rate being used.

Master Section

Clicking on one of the mixes allows you to make changes to that mix. When a mix
is selected, it expands to reveal additional controls for that mix.

Mix Se|ection ..................... e i I Chgnne| VieWS
CUue MixX  weeeeesmenneeennenn. CUE AT SRR Mix Solo
Name B

....................................................... M|X Meters
OV O QVO
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Cue Mix Name
Double clicking on a Cue Mix’s name allows you to rename it. If for example you

were creating mixes for four separate band members, you could name them
‘Drummer’, ‘Guitarist’, ‘Bassist’... etc.

Mix Solo

The Solo button allows you to audition each of the Cue Mixes through your
speakers.

Mix Level

The Mix level allows you to control the overall level of the Cue Mix that is sent to
the outputs.

Mix Meters

The Mix meters show the master signal level of the selected Mix.

Channel Views
These three buttons allow you control which of the three channel types are shown

in the mixer. If for example you weren’'t using the digital inputs for a particular
project, you can simply hide the optical channels by clicking on the OPT control.

Monitor Controls

These five buttons control various aspects of the EVO 16 monitor controller
capability:

TB (Talkback)

The talkback button switches talkback on and off. More information regarding

talkback and its various settings can be found in the ‘System Panel” section of
this manual.



Mono

The mono button sums the stereo outputs down to mono. This can be used to
quickly check the mono compatibility of your mix to make sure it'll sound great
almost anywherel

ALT

Alt allows you to quickly switch your monitor path to a secondary set of speakers
to let you check how your mix translates on various speakers. You can select
which outputs the ALT. monitor control flips to in the System Panel.

Dim

Reduces the output level by a pre-set amount which can be great if you get @
call or need to quickly chat to someone during a session.

Cut

The cut button cuts the signal to the speakers. All these controls can be controlled
fromthe EVO 16 itself, either by assigning them to an F-Key, or using the dedicated
Dim and Cut controls..

Assigning the F-Button

Various functions of the EVO Software Mixer can be assigned to the Function
Key of the EVO 16 to allow you to quickly control your monitoring at the click of
a button. To assign a monitor control to an F-Button, simply right click on the
control and select the F-Button.

v Fl
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System Panel Features

The system panel can be accessed via the menu or simply by pressing the
‘Settings’ shortcut on the mixer front panel.
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Digital Inputs/Outputs

Allows you to select whether each optical input or output uses ADAT or S/PDIF
digital format.

Default Clock Source

The Clock source can be selected from either the internal clock or one of the two
optical inputs. More information about choosing a clock source can be found
in the clocking section of this manual. When using an external clock source the
indicator beside the selector shows the current status of the clock on that input.

e Red - No clock signal detected on input
e Amber - A clock signal is detected but at a different sample rate to EVO 16
e Green - A clock signal is detected and is at the correct sample rate.

Foran external clock source to be working correctly you would want the indicator
to be green. If the indicator isn't green, EVO 16 will default back to the internal
clock until it detects a valid clock input.



Mono Mode

When the EVO 16 Mono feature is engaged this option controls whether the
mono signal is sent to the left, right or both speakers.

Dim Level

When the EVO 16 dim button is pressed, this control defines how much the level
is reduced by.

ALT Speaker Trim

This control defines the level drop/boost when the EVO 16 is switched to ALT
speaker mode. This is used to balance levels between different speaker brands
or types.

Output Routing Selection

Opens the routing matrix for either the Analogue Outputs, Digital Output 1,
Digital Output 2 or the Talkback channel.

Routing Matrix

The Routing Matrix allows you to control the audio source for each of the EVO 16
outputs from the following options:

e Main Mix - This takes signal from the Master Mix of the EVO Software Mixer.
This is what is usually used for most standard playback.

e ALT - This takes signal the Master Mix but only when the ALT speaker mode is
active.

e Cue A, B, C, D - This takes signal from the four cue mixes which can be
created using the iD mixer.

Please note that the hardware volume control does not affect these mixes
and the Cue’s have seperate trims which can be adjusted when the Cue Mix is
selected in the Main Mixer Window.



e DAW THRU - This allows you to route to outputs exactly as they would appear
in your DAW. For example, if you set Analogue out 1+2 to DAW THRU, anything
your DAW sends out to Outputs 1+2 will be sent directly to Analogue outputs
1+2.

This can also be applicable for the digital outputs meaning you can have
numerous sends direct from your DAW out via the optical outputs for adding
outboard gear or for extensive fold-back solutions. As an example, setting
digital outputs 1+2 to DAW THRU would allow you to directly send audio to this
output from your DAW by setting channels in your DAW to playback via outputs
9+10 (outputs 1-8 would be your analogue outputs). Digital outputs 3+4 would be
outputs 11+12... and so on.

Please note that in DAW THRU, the channel in question will bypass any volume
control and audio will be passed at full scale. If this output is sent to a set of
speakers without inline attenuation, this may be very loud. The DAW THRU
function is not available on the headphone outputs.
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Talkback Source

The Talkback source allows the talkback input to be taken from one of the EVO
16 internal inputs or from a device connected to the host computer (such as a
built-in microphone or USB microphone).

When you select an input as your Talkback channel, the channel strip in the
EVO Software Mixer will be changed to a talkback channel which will have a TB
button in the centre. If using an external device, the talkback signal will appear
on channel DAW 10. Faders will only appear for these channels on the Cue Mixes,
not on the Main Mix.



Talkback Device

If an external device is selected then this allows you to select which connected
device is used.

DAW 10



ADVANCED FEATURES

Mic Preamp Controls

The Mic preamps on EVO 16 can be remotely controlled from the EVO Software
Mixer. To enable this go to the “View” menu and select “Show Mic Pre Controls”.

Once this is enabled, on the bottom of each channel, you'll see a gain control
and a +48v button.

The +48v button will enable phantom power on this channel and the Gain control
will adjust the gains on the EVO 16 itself. Allowing you to make quick changes to
your setup without having to look away from the computer during a busy session.

File | View Setup Help

v Show Analogue Inputs 31
WY ¢ Show Digital Inputs 382
v Show DAW Returns 383

v Show Mic Pre Controls &5

Show System Panel g4



Saving and Opening EVO Configurations

If you have a configuration you want to use again in the future then you can save
it as a preset. EVO 16 will save all your settings to allow for speedy recall.

To Save a configuration, go to File > Save.

@ EVO File View Help

Open &O
Save #S
Close &W

You can then give the configuration a name and click Save. If you'd like to send
your settings to another computer or EVO 16 user, you can click ‘Export Mixer
Setting to File’ and you can save this to your documents.
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To open a previously saved configuration, Go to File > Open and select the
configuration from the list..

LN J Podcast Vocals - EVO

evOo

Podcast Vocals

LOAD

You can also delete a previously saved configuration by clicking the red X’ next
toit.

If you'd like to open an EVO 16 configuration from your documents, simply click
‘Load From File’ and then use the file explorer to find the setting you wish to load.

Standalone Operation

If you would like to use EVO 16 without a host computer, EVO 16 can be configured
to operatein standalone mode. This is great for setting up complex tracking setups
in remote locations.

To setup Standalone mode, first setup the iD mixer in the way that you wish to
be saved onto your EVO 16. This includes your digital 1/O settings, output routings
and talkback settings in the System panel.

Now navigate to the Setup menu and select Store Standalone State. The EVO
Software Mixers current configuration will then be saved onto the EVO 16 itself,
ready to be recalled when the EVO 16 is next powered on.



@ EVO File View Setup Help

Set Clock Source >

I A Input Routing p =

Store Standalone State

Using Audio Loop-back on EVO 16

EVO 16 includes Loop-back channels that allow you to take audio from

applications on your computer and feed it to another application, great for

recording video interviews or for setting up gaming streams. You can think of

it as a virtual cable that runs from your outputs and back to the inputs.

Selecting the Loop-back Source

Firstly, you would need to select which output of the EVO 16 you wish to use

as your source for the Loop-back channels. This is done by going to ‘Setup >

Input Routing':

File Wiew
1

Setup  Help

Set ASIO Buffer Size

Set Sample Rate
Set Clock Source
Input Routing

Store Standalone State
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Below is a breakdown of each source and where it takes audio from:

DAW 1+2 - Any audio being sent to outputs 1+2 of the EVO16

DAW 3+4 - Any audio being sent to outputs 3+4 of the EVO16

DAW 5+6 - Any audio being sent to outputs 5+6 of the EVO16

DAW 7+8 - Any audio being sent to outputs 7+8 of the EVO16

DAW 9+10 - Any audio being sent to outputs 9+10 of the EVO16

Master Mix - The audio mix created in the EVO mixer on the Main Mix panel
Cue A - The audio mix created in the EVO mixer on the CUE A panel

Cue B - The audio mix created in the EVO mixer on the CUE B panel

Cue C - The audio mix created in the EVO mixer on the CUE C panel

Cue D - The audio mix created in the EVO mixer on the CUE D panel

Tip - Using the Master or Cue Mixes is a great way of combining audio from a
number of sources (Mic Inputs, Digital inputs, DAW Channel...etc) into one stereo
feed, which is great for streaming apps where you can only use a single stereo

input. See earlier in the manual for how to adjust the Main and Cue Mixes.

The Loop-back icon as a visual aid will appear on the source
you have selected.



Recording/Streaming your

Loop-back Channels

Once you have selected your source, set up your recording/streaming
software to capture audio from the EVO 16’s Loop-back channels. The Loop-
back channels will appear on Channels 23-24.

For example, when using a DAW, create a new stereo track that takes the
signal from Input 23-24. When you hit record, this will record any audio present
on the selected Loop-back source at that time.

Similarly, in a streaming application such as OBS or Zoom, you'd set your input
device to EVO 16 channels 23-24. (Please note that not all applications will
allow you to access channels 23 and 24, which may mean you are unable to
use loop-back with this application).



Firmware Update Procedure

To update your firmware, go to the EVO Application Menu and select ‘Check
for Updates.

Show Mixer

About EVOD
Visit EVO Knowledge Base

Register Product
Check for Updates

Input Routing

Quit

Provided you have an internet connection, the EVO App will now check with
our update service to see if there are any new firmware updates for your EVO
16.

If a firmware update is available, you'll be prompted to install it directly
from our update service. This should take no longer than a minute or so. We

recommended that all speakers are switched off before updating.

During the update procedure, the unit will restart multiple times.






SPECIFICATIONS

MICROPHONE PREAMPLIFIER:

Mic Gain Range:

Line Gain Range:
Phantom Power:
CMRR:

Maximum Input Level:
Input Impedance (Mic):
Input Impedance (Line):
Frequency Response:
Crosstalk:

THD+N @ OdBu (1kHz):
SNR:

Mic EIN:

XLR:

1/4” Jack:

D.I:

D.I Gain Range:
MAXIMUM INPUT LEVEL:
INPUT IMPEDANCE:
THD+N @ OdBu (1kHz):
SNR:

FREQUENCY RESPONSE:
1/4” JACK:

58 dB
58dB with -10dB Pad

48v +/-4v @ 10mA/Channel
>80dB @ 1kHz

+16dBu

>3kQ Balanced

>10kQ Balanced

+/-0.5dB 10Hz to 40kHz
<-105dBu @ 1kHz <-103 @ 10kHz
<0.0015%

100dB

<-127.5dBu

Pin 2 (Hot), Pin 3 (Cold) & Pin 1 (Shield)

TIP (Hot), RING (Cold) & SLEEVE (Shield)

58dB

+10dBu

500k

<01%

100dB
+/-0.5dB 10Hz to 20kHz
TIP (Hot) & SLEEVE (Shield)



ANALOGUE TO DIGITAL CONVERTER

Digital Reference Level:
Frequency Response:
Crosstalk:

THD+N @ -1dBFS (1kHz):

Dynamic Range:

DIGITAL TO ANALOGUE CONVERTER

Maximum Output Level:
Digital Reference Level:
Output Impedance:
Frequency Response:
Crosstalk:

THD+N @ -1dBFS (1kHz):
Dynamic Range:

1/4” Jack:

HEADPHONE OUTPUT:

Max Output Level:
Output Impedance:
Frequency Response:
Crosstalk:

THD+N @ -1dBFS (1kHz):
Dynamic Range:

Max Level Into 30ohms:

Max Level Into 60ohms:

Max Level Into 600ohms:

1/4” Jack:

OdBFS = +10.5dBu
+/-0.5dB 10Hz to Fs/2
-125dBu @ 1kHz & 10kHz
<0.001%

112.5dB A-Weighted

12dBu

OdBFS = +12dBu

<50Q

+/-0.5dB 10Hz to Fs/2
<-110dBu @ 1kHz
<0.001%

121dB A-weighted

TIP (Hot), RING (Cold) & SLEEVE (Shield)

11.25dBu

<50Q

+/-0.5dB 10Hz to Fs/2
-108dBu @ 1kHz
<0.001%

118dB A-weighted

+8.5 dBu, 0.00094% THD+N,
1.66Vpk Power: 86mW

10 dBu, 0.00079% THD+N,
2.55Vpk Power: 104mW

11.2 dBu, 0.00057%THD+N,
3.83Vpk Power: 24mW

TIP (Left), RING (Right) & SLEEVE (Shield)



WARRANTY INFORMATION o

Warranty Statement

Your EVO 16 comes with a manufacturer’s warranty for three years (36 months)
from the date of despatch to the end user.

The warranty covers faults due to defective materials used in manufacture and
faulty workmanship only.

During the warranty period Audient will repair at its discretion or replace the faulty
unit provided it is returned carriage paid to an authorised Audient service centre.
We will not provide warranty repair if in our opinion the fault has resulted from
unauthorised modification, misuse, negligence or accident.

We accept liability to repair or replace your EVO 16 as described above. We do not
accept any additional liability. This warranty does not affect any legal rights you

may have against the person who supplied this product - it is additional to those
rights.

Warranty Limitations
This warranty does not cover damage resulting from accident or misuse.
The warranty is void unless repairs are carried out by an authorised service centre.

The warranty is void if the unit has been modified other than at the manufacturer’s
instruction.

The warranty does not cover components which have a limited life, and which are
expected to be periodically replaced for optimal performance.

We do not warrant that the unit shall operate in any other way than as described
in this manual.



Tel: 0044 1256 381944
IMPORTANT SAFETY INSTRUCTIONS

e Read instructions - All the safety and operating instructions should be read
before the product is operated.

e Retaininstructions - The safety and operating instructions should be retained
for future reference.

e Heed Warnings - All warnings on the product and in the operating instructions
should be adhered to.

 Follow Instructions - All operating and use instructions should be followed.

* Cleaning - Unplug this product from the wall outlet before cleaning. Do not
use liquid cleaners or aerosol cleaners. Use a dry cloth for cleaning.

e Attachments - Do not use attachments not recommended by the product
manufacturer as they may cause hazards.

e Water and Moisture - Do not use this product near water-for example, near a
bath tub, wash bowl, kitchen sink, or laundry tub; in a wet basement; or near a
swimming pool; and the like.

e Accessories - Do not place this product on an unstable cart, stand, tripod,
bracket, or table. The product may fall, causing serious injury to a child or adult
and serious damage to the product. Any mounting of the product should
follow the manufacturer’s instructions, and should use a mounting accessory
recommended by the manufacturer.

* Flame Sources - No naked flame sources, such as lighted candles, should be
placed on the product.



 Ventilation - Slots and openings in the cabinet are provided for ventilation
to ensure reliable operation of the product and to protect it from overheating.
These openings must not be blocked or covered. The openings should never
be blocked by placing the product on a bed, sofa, rug, or other similar surface.
This product should not be placed in a built-in installation such as a bookcase
or rack unless proper ventilation is provided or the manufacturer’s instructions
have been adhered to.

e Power Sources - This product should be operated only from the type of power
source indicated on the marking label and connected to a MAINS socket outlet
with a protective earthing connection. If you are not sure of the type of power
supply to your home, consult your product dealer or local power company.

* Power-Cord Protection - Power-supply cords should be routed so that they
are not likely to be walked on or pinched by items placed upon or against them,
paying particular attention to cords at plugs, convenience receptacles, and
the point where they exit from the product.

e Mains Plug - Where the mains plug or an appliance coupler is used as the
disconnect device, the disconnect device shall remain readily operable.

e Lightning - For added protection for this product during a lightning storm, or
when it is left unattended and unused for long periods of time, unplug it from
the wall outlet and disconnect the antenna or cable system. This will prevent
damage to the product due to lightning and power-line surges.

e Power Lines - An outside antenna system should not be located in the vicinity
of overhead power lines or other electric light or power circuits, or where it can
fall into such power lines or circuits. When installing an outside antenna system,
extreme care should be taken to keep from touching such power lines or circuits
as contact with them might be fatal.

* Overloading - Do not overload wall outlets, extension cords, or integral
convenience receptacles as this can result in a risk of fire or electric shock.



» Object and Liquid Entry - Never push objects of any kind into this product
through openings as they may touch dangerous voltage points or short-out
parts that could result in a fire or electric shock. Never spill liquid of any kind on
the product.

» Headphones - Excessive sound pressure form earphones and headphones
can cause hearing loss.

 Damage Requiring Service - Unplug this product from the wall outlet and
refer servicing to qualified service personnel under the following conditions:

— When the power-supply cord or plug is damaged.

— If liquid has been spilled, or objects have fallen into the product.

— If the product has been exposed to rain or water.

— If the product does not operate normally by following the operating
instructions. Adjust only those controls that are covered by the operating
instructions as an improper adjustment of other controls may result in
damage and will often require extensive work by a qualified technician to
restore the product to its normal operation.

— If the product has been dropped or damaged in any way.

— When the product exhibits a distinct change in performance-this indicates a
need for service.

* Replacement Parts - When replacement parts are required, be sure the
service technician has used replacement parts specified by the manufacturer
or have the same characteristics as the original part. Unauthorized substitutions
may result in fire, electric shock, or other hazards.

* Battery Disposal - When disposing of used batteries, please comply with
governmental regulations or environmental public instruction’s rules that apply
in your country or area.

» Safety Check - Upon completion of any service or repairs to this product, ask
the service technician to perform safety checks to determine that the product
is in proper operating condition.



WARNING 0

THE LIGHTNING FLASH WITH ARROWHEAD SYMBOL, WITHIN
AN EQUILATERAL TRIANGLE, IS INTENDED TO ALERT THE
USER TO THE PRESENCE OF UNINSULATED “DANGEROUS
VOLTAGE” WITHIN THE PRODUCT'S ENCLOSURE THAT MAY
BE OF SUFFICIENT MAGNITUDE TO CONSTITUTE A RISK OF
ELECTRIC SHOCK TO PERSONS.

THEEXCLAMATION POINTWITHINAN EQUILATERALTRIANGLE
IS INTENDED TO ALERT THE USER TO THE PRESENCE OF
IMPORTANT OPERATING AND MAINTENANCE (SERVICING)
INSTRUCTIONS IN THE LITERATURE ACCOMPANYING THE
APPLIANCE.

CAUTION

RISK OF ELECTRIC SHOCK
DO NOT OPEN

WARNING : SHOCK HAZARD - DO NOT OPEN
ATTENTION : RISQUE DE CHOC ELECTRIQUE-NE PAS OUVRIR




CAUTION REGARDING PLACEMENT o

To maintain proper ventilation, be sure to leave a space around the unit (from
the largest outer dimensions including projections) than is equal to, or greater
than shown below.

Itis not advised to run the unitin a rack above hot units such as valve outboard
and multichannel AD/DA converters without suitable ventilation space around
the unit. Ensure side air vents are not covered.

Left and Right Panels: 10 cm
Rear Panel: 10 cm
Top Panel: 10 cm

DO NOT install near any heat sources such as radiators, heat registers, stoves,
or other apparatus (including ampilifiers) that produce heat.

DO NOT defeat the safety purpose of the polarized or grounding - type plug. A
polarized plug has two blades with one wider than the other. A grounding type
plughas two blades and a third grounding prong. The wide blade or the third
prong is provided for your safety. When the provided plug does not fit into your
outlet, consult an electrician for replacement of the obsolete outlet.

Tel: 0044 1256 381944 support@evo.audio.com support.audient.com
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FCC STATEMENT

This equipment has been tested and found to comply with the limits for Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

- Consult the dealer or an experienced radio TV technician for help.

- This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions:

1this device may not cause harmful interference, and
2 this device must accept any interference received, including interference
that may cause undesired operation.

- To prevent electric shock, match wide blade of plug to wide slot, fully insert
(Applies only to devices that uses plug with wide blade).

- For the appliance provided with a protective earth terminal should be
connected

to a mains outlet with a protective earth connection.

- Mains plug is used as disconnect device and it should remain readily operable
during intended use. In order to disconnect the apparatus from the mains
completely, the mains plug should be disconnected form the mains socket
outlet completely.

- Marking and rating plate are located at the back or bottom of the apparatus.






